
Published Date: March 12, 2025 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 

CONNECTICUT DEPARTMENT OF TRANSPORTATION 

DIGITAL DESIGN  

ENVIRONMENT GUIDE 

CONNECT EDITION 
 
 

Volume 5 –  
OpenRoads Designer  

Drainage and Utility Modeling 



Volume 5 –  OpenRoads Designer Drainage and Utility Modeling 

1 
 

Table of Contents 
 
Table of Contents ............................................................................................................................................... 1 

Course Overview ................................................................................................................................................ 3 

Exercise 1 - Getting Started ............................................................................................................................... 11 

1.1 NOAA ATLAS 14 Data ......................................................................................................................... 11 

1.2 Terrain Data ...................................................................................................................................... 14 

1.3 Create a Drainage Model (DGN File) ................................................................................................... 14 

1.4 Set Defaults and Constraints ............................................................................................................. 16 

1.4.1 Options ......................................................................................................................................... 16 

1.4.2 Prototypes .................................................................................................................................... 18 

Exercise 2 - Laying Out Drainage ....................................................................................................................... 19 

2.1 Nodes ............................................................................................................................................... 19 

2.1.1 Place Catch Basin ......................................................................................................................... 19 

2.1.2 Place Culvert End .......................................................................................................................... 21 

2.1.3 Feature Definitions for Drainage Nodes .......................................................................................... 23 

2.1.4 Inlet Catalog ................................................................................................................................. 23 

2.2 Conduit ............................................................................................................................................ 25 

2.2.1 Place Conduit ............................................................................................................................... 25 

2.2.2 Conduit Catalog ............................................................................................................................ 26 

2.3 Input Invert Elevations ....................................................................................................................... 27 

2.3.1 Utilities Properties ......................................................................................................................... 28 

2.4 Define Drainage Areas ....................................................................................................................... 30 

2.4.1 Catchment Area ............................................................................................................................ 30 

2.4.2 Runoff Coefficient ......................................................................................................................... 31 

2.4.3 Time of Concentration ................................................................................................................... 32 

2.4.4 Time of Concentration using Tc Data Collection ............................................................................. 33 

2.5 Placing a Gutter ................................................................................................................................ 35 

2.6 Creating Storm Data .......................................................................................................................... 38 

2.6.1 Create IDF-Table by importing CSV-file .......................................................................................... 39 

2.6.2 Create IDF-Table Adding Return Periods and Durations (quick & dirty) ............................................. 41 

Exercise 3 - Drainage Computation ................................................................................................................... 42 

3.1 Setting Global Storm Events and Alternatives ..................................................................................... 42 



Volume 5 –  OpenRoads Designer Drainage and Utility Modeling 

2 
 

3.2 Validate ............................................................................................................................................ 47 

3.3 Computation and Results .................................................................................................................. 52 

3.3.1 Compute ...................................................................................................................................... 52 

3.3.2 Flex Tables .................................................................................................................................... 53 

3.3.3 Profile for Drainage ........................................................................................................................ 58 

 
 



Volume 5 –  OpenRoads Designer Drainage and Utility Modeling 

3 
 

Course Overview   
The engineer will need a fundamental understanding of drainage design and the Rational Method 
that is used throughout OpenRoads Designer Drainage and Utilities.  

This platform includes storm drainage design and analysis as well as utilities engineering with 
capabilities to include conflict detection and non-drainage attribution. OpenRoads 
.Designer Drainage and Utilities has two drainage calculation options: Analysis will not 
change the physical characteristics of the storm drainage; Design may change the physical 
characteristics. 

 

 

When possible, drainage components have been set-up to follow CTDOT standards and methods. 
The engineer is responsible to verify drainage items properties. 

Skills Taught 
• Obtain NOAA Atlas Data for Point Precipitation Frequency (PF) Estimates 
• Node and Pipe layout 
• Storm data input 
• Preform and review computations 

 

Introduction 
Drainage and Utilities uses the terrain model referenced into a DGN file to display the storm 
drainage and other utilities in 2D and 3D. Drainage structures and conduits are fully integrated in 
graphic and database functions. The data is in the graphics within the design file (*.dgn file). The 
design file is part of a “federated” dataset. Design files are segregated by purpose > different 
engineering object types or scopes are in their own file. The project is assimilated through the 
dynamic use of reference files. 

Use Drainage and Utilities to:  
• Analyze the existing storm drainage for a project site, a single system or multiple, or 
• Analyze the existing storm drainage and upgrade for a project site as needed/required or 
• Analyze and/or design proposed storm drainage system(s) for a project site and 
• Analyze conflicts between existing utilities and proposed drainage. 

The designer will be working in the 2D model, Drainage and Utilities will create the 3D model the 
same way as in ORD. 

It is the designer’s responsibility to adhere to the CTDOT Drainage Manual, CTDOT 
Hydraulics & Drainage Directives and Standards. 
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Tools 
This guide will not document each tool that is available in the OpenRoads Designer Drainage and Utilities 
interface. See the Bentley Online Help for commands not detailed in this document. 

 
Figure 1 Drainage and Utilities Workflow 

Home Tab 

 
Figure 2 Drainage and Utilities Home Tab 

Attributes – with most workflows, it shows all attributes that are active. 

Primary – opens the explorer, properties, attach tools for references and raster files, level 
manager, level displays (common MicroStation tools). 

Selection – houses the Element Selection tool, Select All, Select None and Fence tools. 

Civil Analysis – gives the user the option to analyze various items. 

A useful tool for the drainage design is the Analyze Trace Slope - The Trace Slope 
tool shows the down/up slope direction of the slope at anyone point within the active 
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terrain.  The Trace Slope tool should be used in its separate file and referenced into 
the drainage file as needed. 

 
Figure 3 Analyze Trace Slope 

Model Import/Export - various import and export options.  

Terrain Import – creates a terrain model from File, Ascii File, Elements, and Point Cloud etc., 
see Bentley Online help for more Terrain options. Import Geometry from various file types.  

Import Utilities – import drainage data from various other software, i.e. InRoads and Export 
Utilities to various other software, see Bentley Online help. 

Export Utilities – export drainage data to various other software, see Bentley Online help. 

Terrain import, geometry import or import utilities should be done in a separate file and 
referenced into the drainage file as needed. 
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Layout Tab 

  
Figure 4 Drainage and Utilities Layout Tab 

The Layout tab allow the user to place utility structures and connect the structures with 
conduits. The utilities can be below the surface, on the surface or above the surface. 

Layout - this is the main tool to place utilities, such as drainage structures and pipes, this will 
be explained. 

Profile Runs - are profiles along a series of structures.  Different profiles can be created from 
the Start Node or the Outfall and Links can be added to a profile run. 

Toggles - will open/activate Civil Accudraw and the Civil Message Center. 

Analysis Tab 

 
Figure 5 Drainage and Utilities Analysis Tab 

The Analysis tab set calculation parameters, standards, constraints, and scenarios for 
drainage items. 

Calculation - this is the center for drainage calculations.      

Analysis Tools - holds the Compute Center (one tool box for access to calculations), 
Default Design Constraints are set to CTDOT standards and should be reviewed for project 
specific constraints (i.e. max. spread, conduit slope), Show Gutter Flow will show the path of 
any overflows from catch basins.  

Analysis Views - houses the flex tables – CTDOT specific flex tables for hydraulic analysis 
have been established, queries can be used to report on specific item 
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Components Tab 

 
Figure 6 Drainage and Utilities Components Tab 

The Components tab are used to establish project specific storm data, drainage properties 
and settings. 

Common - create – import Storm Data, select Global Storm Events.      

Catalog - access to engineering libraries, inlet – gutter – conduit catalogs, culvert inlet 
coefficients and rainfall curves from csv files.  Prototypes for drainage items are set to 
CTDOT Standards and can be updated to project specific data if needed. 

Trenches - access to template tools – edit template drop – apply linear template for 
trenches used in the design.  

Utilities View Tab 

 
Figure 7 Drainage and Utilities Utilities Viewer Tab 

The Utilities View tools open views of various drainage properties. 

Drawing Views - element symbology allows control how elements and associated label are 
displayed; open profile model generates a view presenting a desired feature in profile; 
open cross section view creates a dynamic cross section of a selection item; these are the 
ORD Modeling tools.       

Results Views - houses the Flex Tables – CTDOT specific Flex Tables for hydraulic analysis 
have been established and the user can view input data and results for all elements of a 
specific type in a tabular format. 

Selection and Query - create, edit, and navigate selection sets; display all queries in the 
current hydraulic model; open the network navigator. 
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Element Views - Properties displays a dialog box containing selected elements associated 
properties; Utility Properties displays the subsurface utilities and hydraulic analysis of a 
selected element; Prototypes displays and allows edit to default values for elements in a 
network.  Prototypes have been set-up to CTDOT Standards, the engineer needs to verify 
the items in the project. 

Customize - Customize Properties allows customization and changes to default user 
interface; Customize Tooltip allows customization of tooltips that appear when hovering 
over an element.  

Tools Tab 

 
Figure 8 Drainage and Utilities Tools Tab 

The Tools tab is divided into general tools and project tools. 

Tools - utilities conflicts allows detection of physical clashes and clearances between 
elements; user data extensions allows adding data fields to the hydraulic model toolbox; 
model builder allows existing GIS assets to construct a new model or update an existing 
model; update descriptions of conduits in the model; branch labeling sets the labels of 
conduits; set feature definition allows setting/locking a feature definition.      

Project Tools - houses project defaults, i-model configuration to export drainage 
calculations, project properties, synchronize drawing and annotation tool to label the 
drainage items. 

License Activation - StormCAD Unlimited.  
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Report Tab 

 
Figure 9 Drainage and Utilities Report Tab 

The Report tab gives the user fast access to various reports for Tables, Civil and Drainage 
and Utilities. 

Report - Custom Report allows the user to assemble a wide variety of model input, results, 
graphs, etc. in a customized report. 

Tables - access to all Flex Tables and Network Elements Table for the utility project. 

Civil - access to civil reports such as horizontal geometry report and corridor reports. 

Drainage and Utilities - access to various reports and summaries for the drainage design. 

Drawing Production tab 

 
Figure 10 Drainage and Utilities Drawing Production Tab 

The Drawing Production tab is divided into tables, notes, text, annotation and named 
boundaries, explanations are found in detail under Volume 13.  

Drawing Production tools enables the user to place notes and labels; place and edit text; 
annotate an individual element or an entire model; enables sheet production through the 
Named Boundary tool. 
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Workspace Files 

Feature Definitions 
…CT_Configuration\Organization-BIM\_CT_Civil Standards\Dgnlib\Feature Definitions\  

• CV_DU_Ex_Features_Levels_ElemTemp.dgnlib 
• CV_DU_Pr_Features_Levels_ElemTemp.dgnlib 

 

Cells 

…CT_Configuration\Organization-BIM\_CT_Civil Standards\Cell\ 

• CV_DU_Ex_Ends_Walls.cel 
• CV_DU_Pr_Ends_Walls.cel 
• CV_DU_Utilities.cel 
• CV_DU_Ex_CB_MH.cel 
• CV_DU_Pr_CB_MH.cel 

 

Inlet Library 

…CT_Configuration\Organization-BIM\_CT_Civil Standards\Data\  

• CV_SubsurfaceUtilitites_Inlets.xml 

These files will be updated as needed by AEC Applications to incorporate changes in the CTDOT 
standards. Should the designer find an item changed or was added (example: new wing wall) 
please bring this to the attention of AEC Applications. 
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Exercise 1 - Getting Started 
The designer should compile the information and material necessary to complete a 
drainage design. The most commonly needed items for a drainage design (existing or 
proposed) are storm data and terrain data for the project. 

1.1 NOAA ATLAS 14 Data 

The Department’s Hydraulic and Drainage Unit advises the designer to use the NOAA Atlas 14 
data, which can be accessed through the NOAA ATLAS 14 POINT PRECIPITATION FREQUENCY 
ESTIMATES webpage in conjunction with the CTDOT Drainage Manual. 

Follow the direction on the NOAA Atlas 14 webpage and directions given by CTDOT Hydraulics 
& Drainage unit on how to develop the Point Precipitation Frequency (PF) Estimates, which can 
be downloaded in CSV-format and opened with Excel.  The data in the PF tabular format will be 
used for Storm Data to create a User Defined IDF Table. 

 
Figure 11 NOAA Atlas 14 

https://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html?bkmrk=in
https://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html?bkmrk=in
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Scroll down the webpage, making sure CSV format is set to: Precipitation Frequency 
Estimates and click Submit. 

 
Figure 12 Precipitation Frequency Estimates 

Either select Open, Save or Save As, (save to Project directory). 

 
Figure 13 Save, Open, Cancel Buttons 
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The Excel file will be used to create an IDF-Table for the projects storm data. The options 
available to create an IDF-table will be covered later in this manual. 

 

Figure 14 Excel file IDF-Table 
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1.2 Terrain Data 

Drainage and Utilities uses the terrain model referenced into a DGN file to display the storm 
drainage and other utilities in 2D and 3D models. Drainage structures and conduits are fully 
integrated in graphic and database functions. The data is in the graphics within the design file 
(*.dgn file). 

Drainage and Utilities can use the elevations from the active terrain, but Drainage and Utilities 
can only work with one terrain; this can make it necessary to merge terrains such as existing, 
LIDAR, point clouds and/or proposed into one terrain. The designer should create a specific 
“drainage terrain” for use with the drainage layout and calculations. 

To merge two or more terrains, add Lidar data the user should visit Bentley Help - Terrain Edit. 

This “drainage terrain” is in its own MicroStation DGN file and is referenced into the “drainage” 
MicroStation DGN file. 

1.3 Create a Drainage Model (DGN File)  

Ensure OpenRoads Designer Connect Edition is set to the correct Workspace and Workset. 
Create a new *dgn file (2D) exclusively for your storm drainage layout, calculations, and utility 
conflicts. 

1. From the New dialog box, browse to the proper discipline folder, enter the file using Civil 
Design CAD File Naming Conventions DD_DC_PROJ_NUMB_Description.  

Example: HW_CB_1234_1234_ProposedDrainage.dgn 

2. Change the workflow to: Drainage and Utilities (upper left corner), open the Drainage and 
Utilities Model within the Explorer dialog box.  

 
Figure 15 Drainage and Utilities Workflow 
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3. From the Home tab use the Attach Tools - References to attach the survey, terrain, aerials, 
and design files as needed. Turn OFF Levels as needed from the individual files. 

 
Figure 16 Attach Tools - References 

4. Set the Active Terrain. Using the Element Selection tool click on the boundary line for the 
terrain, hover over it, select the tool Set As Active Terrain Model, this will make the terrain 
active and will be used for placing the drainage structures. 

5. In the 2D view (Default) override the Symbology and turn off triangles. Open the Default 3D 
view and set-up as needed to your preference. 

 
Figure 17 Set As Active Terrain Model 

6. Save settings. 

7. The Drainage and Utilities Hydraulic Engine needs to be activated. From the Layout tab, 
select the Place Node command. This has to be done once per DGN file to activate the 
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utility model and to create the hydraulic project. Only one hydraulic project per dgn 
file, but multiple systems can be place and calculated. 

 

Figure 18 Utility Model Creatin Warning Box 

8. The You Cannot Undo This Action message box will open, click Yes. This will open and 
prepare the Drainage and Utilities project in your DGN file, some context menus will pop-up 
and disappear, wait until completed and your cursor comes back. Now you are ready to 
place your structures, conduits, catchment areas and do your calculations. 

1.4 Set Defaults and Constraints 
Some project specific properties, defaults and constraints need to be reviewed and set for 
each project, where possible CTDOT standards have been set.  

1.4.1 Options 

1. Click on the Tools tab and select Options - Drainage. The Options box opens. 

2. Hydraulic Model tab:  

• Pipe Length – Use 3D Length?  is unchecked. 
• Units tab: Default Unit System for New Project is set to: US Customary 
• make sure all units are set correctly.  Such as rainfall intensity is set to the 

intervals as shown on the NOAA PPF Estimates. 
3. Click OK. 

4. Click on the Analysis tab and select Default Design Constraints. 
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Figure 19 select Options - Drainage 

The constraints have been set to follow the CTDOT Drainage Manual where possible. If you 
want Drainage and Utilities to design your drainage system, it is especially important to 
review, edit and make changes to follow design standards for the individual project, such 
as maximum spread. The Drainage and Utilities Help menu should be used for each 
specific explanation of the Default Design Constraints topic. 

 
Figure 20 Default Design Constraints 
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1.4.2 Prototypes 

1. Click on Components > Catalog > Prototypes.    

Prototypes allow for entering default values for elements in a drainage network and are 
used to define the hydraulic properties of features. A prototype works in cooperation 
with element templates and feature definitions to define the characteristics of a 
drainage feature. The most widely used conduits, gutters, catch basins, manholes, cross 
sections, catchments, and headwalls etc. have been set to CTDOT Standards.  

 

 

 
Figure 21 List of Prototypes 

Some properties are project specific and should be edited as an 
individual item within the items Hydraulic Analysis. It is important the 
engineer reviews and edits these to fit project needs. See the Bentley 

Help menu for further explanation of the prototype settings. 
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Exercise 2 - Laying Out Drainage 

2.1 Nodes 

2.1.1 Place Catch Basin 

1. In View Attributes turn off Fill to only see the outline of structures (catch basin, etc.), this 
will help when placing nodes and conduits. 

2. Select the Place Node command to lay out your drainage structures: catch basins, 
endwalls, etc.  

 
Figure 22 Place Node 

3. Click on the reference element for node elevation (active terrain or edge of road) or 
click reset to type a node elevation, type in 0.00 for vertical offset, this can be changed 
later for the gutter depression of Type "C" catch basins. Rotate as needed to place. 

 
Figure 23 Place Node Settings 
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4. Hover over the node to enable the context toolbox: properties, utility properties and 
delete. The node can be moved and rotated. 

5. Continue placing more structures (catch basins, end structures or manholes). After 
you placed the last structure, right click once more, and select the Element Selection 
tool to end the Place Node command. 

 
Figure 24 Catch Basins Placement Criteria 
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2.1.2 Place Culvert End 

1. Select the Place Node command to place a culvert end. 

2. Select the Feature Definition (example: 24" RCCE) and follow the pop-up prompts. The 
Name Prefix is RCCE- by default. 

3. Click on the reference element for node elevation (active terrain or edge of road) or 
click reset to type a node elevation, type in 0.00 for vertical offset. Rotate as needed to 
place. 

 
Figure 25 Culvert End Placement Criteria 

4. After the conduit is placed click and hover over the culvert end for the context menu, 
click on properties. 
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5. In the properties box, change the following: 
• Use Slope of Surface = False 
• Match Slope of Conduit = True 

 
Figure 26 Culvert End Properties Update 
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2.1.3 Feature Definitions for Drainage Nodes 

1. To view the available Drainage nodes expand the OpenRoads Standards area in 
Explorer. Click Standards > Libraries > Feature Definitions. 

2. Select either Feature Definition (CV_DU pr…) or (CV_DU Ex…) 
3. Select Drainage and Utilities > Node > Catch Basins and review the options. 
4. Browse the other listed folders. 

 
Figure 27 Available Drainage Nodes 

2.1.4 Inlet Catalog 

All inlet nodes (structures) available for design are stored in the Inlet Catalog. This catalog 
has been set-up for all catch basin types and other structures according to CTDOT 
standards.  

To view the inlet catalog: Click the Components tab – Catalog – Inlet Catalog 
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Figure 28 Inlet Catalog 
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2.2 Conduit 

2.2.1 Place Conduit 

Conduits are placed between nodes such as catch basins, manholes and head- and end 
walls. 

Note: If a structure is deleted the associated conduit connecting the node is also deleted. 

 
Figure 29 Place Conduit 

1. Select the Place 
Conduit command, choose 
the Feature Definition for the pipe 
you want to place (example: RC 
Pipe). The Name Prefix 
is SW- (Storm Water) by default. 
The Type: is greyed out – this 
comes from the conduit catalog 
already 
attached, for Description click on 
the down arrow to select the pipe 
size (example: 15”). 

2. Follow the prompts: Select Start 
Node, in the drawing hover your 
courser over/close to the first inlet 
(node i.e. catch basin), it will snap 
to the node where the conduit can 
connect, this is called 
the Connection 
Region. Accept (left click).  

Figure 30 Place Conduit Criteria 
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3. Select next node to make a connection. Again, hover your cursor close to the inlet to 
connect the conduit to (second node i.e. catch basin). Accept (left click).  

4. Continue to place conduits to connect the drainage structures from the first inlet to the 
outlet for the system. Select the Element Selection tool to end the place conduit command. 

2.2.2 Conduit Catalog 

Go to Components - Conduit Catalog to see available conduits. In the Conduit Catalog the 
designer is able to set conduits Available for Design for the drainage design. 

 

Figure 31 Conduit Catalog 
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2.3 Input Invert Elevations 

After completing the layout for the drainage structures and conduits you will enter the invert 
elevations for all structures and conduits, Drainage and Utilities sets conduit inverts to the 
bottom of the structures by default.  

Drainage and Utilities has the capability to calculate the pipe inverts when you use the Base 
Design Scenario in the Hydraulic Analysis. The Default Design Constraints need to be set for the 
project as required. It is recommended the designer reviews the Bentley Learning 
path for Hydraulic Analysis and Design in OpenRoads Designer. 

By selecting a placed utility feature, some feature properties can be edited, rotated and/or 
moved in the graphic (just as with other OpenRoads tools), it shows the label and level.  Also, 
the context toolbox displays and offers two options to input/edit utility information: 

Properties - lists the CADD properties such as level, color, feature, feature definition etc.; and 

Utility Properties- lists every available hydraulic property including user customized 
properties. 

 
Figure 32 Properties vs Utility Properties 

Drainage and Utilities tools represent the merger of two diverse technologies. OpenRoads 
Designer builds the 3D models of the utilities, but Bentley's Haestad technology (StormCAD) 
executes the analytic modeling for hydraulic and utility engineering. We will concentrate on 
Utilities Properties.  

https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=111748
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2.3.1 Utilities Properties 

2.3.1.1 Node 
Click and hover over a node (catch basin or manhole) from the context toolbox 
select Utility Properties, click on the Hydraulic Analysis tab. 

Check and edit the physical properties for the node: 
• Elevation (Ground) = Terrain elevation at node 
• Set Rim to Ground Elevation?  False/True 
• Elevation (Rim) = Top of Grate elevation 
• Elevation (Invert) = bottom elevation of structure 
• Update and edit Inlet properties for the node: 
• Inlet Type: set to Catalog Inlet (CV_SubsurfaceUtilities_Inlet.xml) 
• Inlet: click the down arrow and select from the available structures 
• Other items edit can be edited later 

 
Figure 33 Utility Properties, Hydraulic Analysis tab 

The Inlet catalog: CV_SubsurfaceUtilities_Inlet.xml has been set-up for CTDOT catch 
basin standards and will be updated as needed.The catalog should be available 
automatically when starting the drainage engine, but is also available here: 

…CT_Configuration\Organization-BIM\_CT_Civil Standards\Data\ 
CV_SubsurfaceUtilties_Inlet.xlm 
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2.3.1.2 Conduit  
Click and hover over a conduit, in the context toolbox select Utility Properties, click on 
the Hydraulic Analysis tab. 

Check and edit as needed the Physical Properties for the conduit: 
• Conduit Type: Catalog Conduit 
• Catalog Class: click the down arrow and select: Concrete, PVC, CMP 
• Size: click down arrow and select size 
• Invert (Start): enter elevation 
• Invert (Stop): enter elevation 
• Has user Defined Length? True (default) or False 
• Length (user defined) enter length 
• Other items will be edited later 

 
Figure 34 Utility Properties, Hydraulic Analysis tab 

Most used conduit classes have been added to the catalog, if others are needed those can 
be added: 

Click Catalog – Conduit Catalog – Import from Library 

Select the conduit to add from the available Conduits Library.xml. 
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2.4 Define Drainage Areas 

Drainage areas are defined using existing and proposed terrains, which can be merged with 
terrains coming from various other sources such as LIDAR. 

There are several options to place catchment areas (see Bentley Help): 
• Place Catchments by Picking Shapes 
• Place Catchments by Picking Points 
• Place Catchments by Flood Fill 

Catchment properties include catchment area, runoff coefficient, time of concentration types, and time of 
concentration. 

2.4.1 Catchment Area 

1. From the Layout Tools select Place Catchment and select the Method that best serves 
your purpose: example Pick Points 

2. From the Feature Definition pick the land use most appropriate for the catchment area: 
example Pavement 

 
Figure 35 Place Catchment TOOL 

3. For each land use prototypes have been 
created that follow the CTDOT Drainage Manual. The 
designer should adjust the Runoff Coefficient 
(Rational) for the project if needed in the 
Hydraulic Analysis tab for the catchment area.  

4. Follow the command prompts: Select First 
Vertex, Select Next Vertex, (Reset) To 
Complete, Select Outflow, and Select 
Reference Surface. 

Figure 36 Select Prototype 
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2.4.2  Runoff Coefficient 

Runoff Coefficients have been defined as prototypes following the CTDOT Drainage 
Manual.  They are composites from Chapter 6 – Runoff Coefficient – Table 6-4 
Recommended Coefficient of Runoff Values for Various Selected Land Uses and Table 6-5 
Coefficients for Composite Runoff Analysis. More Catchment types can be added and/or 
the coefficients can be changed specific to the project need. 

 
Figure 37 Runoff Coefficients List 
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2.4.3 Time of Concentration 

Time of Concentration (Tc) is defined as the time required for a particle of runoff to flow 
from the hydraulically most distant point to the outlet or design point (catch basin etc.). 
Factors affecting the Tc are length of flow, slope of flow path and roughness of flow path.  

Please see the CTDOT Drainage Manual - Chapter 6 for more detail. 

Tc Input Types: 
• User Defined Tc -where the user inputs minutes for Tc or 
• Composite Tc -where the user inputs a data collection of Tc’s (Tc Data Collection) 

 
Figure 38 Time of Concentration Information 



Volume 5 –  OpenRoads Designer Drainage and Utility Modeling 

33 
 

2.4.4 Time of Concentration using Tc Data Collection 

This follows the CTDOT Drainage Manual by using the TR-55 Sheet Flow, Shallow 
Concentrated Flow and Channel Flow Tc Data Collection method. 

SHEET FLOW 

 
Figure 39 Sheet Flow 

  

SHALLOW FLOW 

 
Figure 40 Shallow Flow 
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CHANNEL FLOW 

 
Figure 41 Channel Flow 
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2.5 Placing a Gutter 

Gutters are the method by which a catch basin bypass flow is assigned to a downhill catch 
basin (inlet).  Gutters only represent the hydraulic relationship between the inlets and are not 
accurate 2D and 3D models. 

To display and add gutters to a drainage system: 
• Turn Off Annotation Scale Lock (it is usually turned on by default): Drawing Production 

tab – Drawing Scales tools – Annotation Scale Lock 

• Change the display in the 2D view to use Analytic Symbology.  In View 1, Default (2D 
view) click on View Attributes, check off ‘Text’ under Presentation, then expand 
the Analytic Symbology (if not expanded) and check on “Use Analytic Symbology”. 
This will turn on “labels” in the plan view (2D view only). If the labels do not show, refresh 
the view. 

 

Figure 42 Place a Gutter Setup 
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There are four (4) gutters available that correspond to the CTDOT Drainage Manual, Chapter 
11 – Storm Drainage Systems, 11.9 Gutter Flow Calculations: 

• 11.9.3 - Uniform Cross Slope Procedure and 
• 11.9.3 - Full-Super Uniform Cross Slope Gutter 
• 11.9.4 - Composite Gutter Sections Procedure and 
• 11.9.5 - V-Type Gutter Sections Procedures.  

The engineer (user) has to decide which gutter best fits their project and edit as needed. 

 
Figure 43 Gutter Properties 

1. From the Layout tab, select the Place Gutter tool. 

2. From the Feature Definition select the Gutter needed for your project. 

3. Example: Uniform Cross Slope Gutter for proposed, Uniform Cross Slope eGutter for 
existing. 
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4. Follow the prompts:  Select Start Node. 

 
Figure 44 Place Gutter Criteria 

5. Select next node to make connection. <Alt> to place curve. <Ctrl> to place bends. 
<Reset> to select start node. Example select the next node. 

 
Figure 45 Place Gutter Criteria 

6. After placing the gutters turn off the analytic symbology under view attributes. 
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2.6 Creating Storm Data 
Storm Data is a single rainfall curve that represents one rainfall event for a given recurrence 
interval. Once the storm data is created it can be used globally by selecting Global Storm 
Events.  

1. Click on the Components tab and click on the Storm Data tool. Several methods for 
specifying storm data are available, the User Defined IDF Table will be discussed and used. 

2. Right-Click on User Defined IDF Table, New, User Defined IDF Table. 

3. Right-Click to rename the new User Defined IDF Table; 
example IDF_Table_Prj_No_XXX_YYYY 

 
Figure 46 Strom Data Dialog Box 

There are two options for the precipitation frequency estimates to be imported or 
used:  Importing an IDF Table from a File or Creating a New IDF Table using the Dialog. 
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2.6.1 Create IDF-Table by importing CSV-file 

• Use Excel to open the PF_Intensity_English_PDS.csv file saved from NOAA Atlas 14. 
• You need to edit the file to only show the columns for durations and the rows for 

minutes. 
• It is recommended to edit further by adding/interpolating the data for more minutes, 

follow Hydraulic and Drainage recommendations. 
• To import an IDF table the data has to be in either the CSV-format or in a TXT-format. 

 
Figure 47 Create IDF-Table by importing CSV-file 

1. In the Storm Data box select the user Defined IDF Table (IDF_Table_Prj_No_XXX_YYYY) 
and click on the Import icon.  A Warning message will come up (Importing data will 
clear all ….) click Yes.  

 

Figure 48 select the user Defined IDF Table 
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2. In the Explorer select and open the NOAA Atlas 14 (edited & interpolated) CSV-file. Imported data 
will be populated in the Storm Data window. 

 

Figure 49 NOAA Atlas 14 CSV-file 

3. Close the Storm Data box. 

4. Select the Tools tab, click Options, Drainage – this will open the Options box. 

5. In the Options box click on the Units tab. Scroll down to the Rainfall 
Intensity and ensure that it matches the units in the IDF file. Click OK. 

 
Figure 50 Drainage Options Match Intensity Units 
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2.6.2 Create IDF-Table Adding Return Periods and Durations (quick & dirty)  

 
Figure 51 Definition of Quick and Dirty 

Repeat steps 1 through 3 to create an IDF-Table. Instead of importing a CSV-file, we are 
adding data into the Storm Event Input. 

• In the Storm Data box under the Storm Event Input tab, click on the down arrow 
for Add Range… 

• Add the years needed for your project; example: 2 enter, 5 enter, and so on for: 10, 25, 
50, 100 years.  

• Click on the down arrow for Add Duration and Add Range… Enter the data from the 
saved PF_Intensity_English_PDS.csv file.  

Start in the first column, enter the data, tab to the next column, and enter the data and so 
on. 

 

Figure 52 Storm Event Input 
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Exercise 3 - Drainage Computation 

3.1 Setting Global Storm Events and Alternatives 

Drainage and Utilities calculations are run on groups of settings called Scenarios, which have 
distinct subgroups of settings focused on aspects of drainage design or analysis. The 
subgroups are called Alternatives and include scopes as Physical Alternative, Design Option 
Alternatives and Rainfall Runoff Alternatives (focus here). Each Rainfall Runoff 
Alternative points to a Storm Event selected from the Storm Data collection (the IDF-Table 
imported previously). 

Storm Events used for analysis and design of storm drainage systems are usually:   

• 2-year for water handling 
• 10-year for the drainage system and 
• 25-year and/or 50-year for sag condition 

(See Table 11-2 Pavement Drainage Design Criteria, Chapter 11 – CTDOT Drainage Manual) 

 

Figure 53 Storm Events 

1. Select the Components tab, click on Storm Data, click on Global Storm Events. You should 
see one Alternative - Base Rainfall Runoff.  

2. Click inside the Global Storm Event box for Base Rainfall Runoff.  
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3. Click on the ellipsis (…) and select the IDF_Table_Prj_No_XXX_YYYY created 
previously and the year you would want as your base rainfall runoff and click Close.  

4. Close the Global Storm Events box. 

5. Select the Analysis tab, here tools are combined to calculate and report on the drainage 
scenarios.   

6. The Analysis tab is split into three (3) sections: Calculation, Analysis Tools and Analysis 
Views. Most tools in the Calculation section are also available in the Compute Center box 
from the Analysis Tools section. 

 
Figure 54 Analysis Tools - Compute Center 

 

 
Figure 55 Compute Center tools 
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Select the Scenarios icon, there are two Scenarios: Base Design and Base Analysis.  

• Base Design will resize pipes, change inverts to Default Design Constraints. 

• Base Analysis will not resize pipes or change inverts but will check if pipes and inverts 
conform to Default Design Constraints. Any discrepancies will be shown in ‘User 
Notifications’ after verified or computed.  

 

Figure 56 Scenarios Properties 

1. Click on the Scenarios icon for the Scenarios box to open. 

2. Select the Base Analysis, right-click and click on Properties, click on the Hydraulic 
Analysis tab in properties. 

 
Figure 57 Hydraulic Analysis Rainfall Runoff setting 
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3. Click on Rainfall Runoff, click on the down arrow next to Base Rainfall Runoff 
and click <New…>. 

4. In the Create New Alternative box enter a new rainfall alternative for your Project: Base 
Analysis - 2-yr Storm, click OK. 

 
Figure 58 Create New Alternative 

5. Select <New…> again add more Rainfall Alternatives as needed: 

• Base Analysis – 10-yr Storm 
• Base Analysis – 25-yr Storm 
• Base Analysis – 50-yr Storm 

 
Figure 59 Create New Alternative Properties 

6. Select the Base Analysis you want to run, example: Base Analysis - 10-yr 
Storm. Close the properties box. Close the Scenarios box.  

7. Select the Components tab, click on Global Storm Events. There are now additional 
alternatives. 

8. Change the Global Storm Event to the projects corresponding event storms (2-yr, 10-yr, 
25-yr and 50-yr). For Base Analysis – 2-yr Storm click on down arrow and select:  IDF 
Table_Prj_No_XXX_YYYY – 2 Year. Repeat for each Base Analysis and Storm. 
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Figure 60 Global Storm Event 

9. Select the Analysis tab and select the Scenarios icon. Right-click on Base Design and 
select Properties. Click on the Hydraulic Analysis tab. 

10. Change the Rainfall Runoff to the Base Analysis as previously. Example: Base 
Analysis – 10-yr storm. Close the properties box. 

 
Figure 61 Properties – Scenario – Base Design 

11. This is the minimum preparation needed to Compute the storm drainage system(s) for 
a project. 
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3.2 Validate 

The Validate command is in the Analysis tab – Calculation section and within the Compute 
Center menu box. The Validate command will run a diagnostic check on the network data 
(drainage system) and alert you to possible problems that could be encountered during the 
calculations. This is a manual validation and checks only for input data errors. 
The Compute command is the automatic validation that Drainage and Utilities runs when it is 
initiated, and it will check for input data errors and for network connectivity errors as well as 
many other things beyond the manual validation checks. It is a good idea to first check 
(validate) the drainage system for any input data errors or missing items/data especially 
when there is a large system. This may need to be done multiple times, because some errors 
may be hidden after the initial validation. 

 

Figure 62 Validate 

Click on the Validate command, you will/may get a message for errors or warnings: Click OK. 
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Figure 63 Validate Warning 

After the validation is complete you will probably see two different kinds of markers in your 
2D view window (usually View 1, Default). 

 

Figure 64 Validate Symbols 

Click on Notifications or the User Notification icon in the Compute Center. 
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Figure 65 User Notification 

The notifications window will come up displaying a list of warnings generated during the 
validation process. There are two types: 

Red error must be corrected before the model (system) can be computed. 

Yellow does not prevent successful calculation of the model, but element does not meet 
certain criteria. 

 

Figure 66 User Notification Symbols 

In the user Notification box, you will see messages with the RED and/or YELLOW icon as well 
as a toolbox (see below). 
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Figure 67 User Notification List 

Example of User Notifications: 
• Message:  The calculation option Structure Loss Mode must be set to EGL in order to use 

the HEC-22 Energy (Third edition) Headloss Method. 
• Meaning:  Inlet calculations use the Headloss Method: HEC-22 Energy (3rd Edition) to use 

this, the Structure Loss mode must be set to the Energy Grade Line (EGL) in the 
Calculation Options. 
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• Solution:  Analysis tab, Options, Right-Click on Base Analysis, Properties. In the properties 
box, select Structure Loss Mode and select Energy Grade. 

 

Figure 68 Example of User Notifications 

Some more examples: 

Message — Meaning — Solution: 

There is no gutter leaving this ‘On Grade’ catch basin.  Bypassed flow is directed to the 
subnetwork outfall.  —  The catch basin doesn’t have a gutter attached.  —  Open the 
Analytical View and place a gutter to direct the flow to next catch basin or system. If 
going to overland flow (no curbing) you can disregard.  

Conduit does not meet minimum cover constraint.  —  The min. cover that is set in Default 
Design Constraints is not met.  —  Change the inverts, or size or add barrel if possible, or 
ignore for calculations and use Class V RCP for callouts and estimating. 

Structure and pipe inverts do not agree with selected benching type. — Benching method 
is set to HEC-22 Benching Method = Flat in accordance with the CTDOT Drainage 
Manual. — You can disregard this message. 
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3.3 Computation and Results 

3.3.1 Compute 

You are ready to compute after all RED issues are resolved and all YELLOW issues are 
modified or considered. 

1. Click the Compute icon.  Drainage and Utilities will run the calculations, you will see 
some windows pop-up, wait until the GVF-Rational Calculation Summary box opens. 

 
Figure 69 GVF-Rational Calculation Summary 

2. Calculations were successful if you see: Convergence was achieved in the Calculation 
Executive Summary box. 

3. Click on Messages… to see the newest User Notifications, if there is an error, the 
calculations will stop at that point, you will have to solve the error and rerun calculations. 

4. Click on Report and for the Scenario Summary preview, this can be printed. 

5. Click Details… the Calculation Detailed Summary box will open showing:  

• Calculation Options 
• Catchment Summary 
• Link Summary 
• Node Summary 
• Inlet Summary 
• Pond Summary 
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6. Click on Report to get one combined report to review/print/save. For individual and 
more complex reports use Flex Tables. 

 

Figure 70 Calculation Detailed Summary 

3.3.2 Flex Tables 

Drainage and Utilities shows the engineering data in tabular format called Flex Tables. The 
most common flex tables have been established as CTDOT Flex Tables have been 
formatted to follow the CTDOT Drainage Manual. Any flex table can be edited to best fit the 
project. The designer should use the drainage manual as a guide to determine the 
information needed to represent the drainage system. 

https://portal.ct.gov/DOT/Hydraulics-and-Drainage/Drainage-Manual
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Click the Flex Tables icon in the Analysis Views section. In the Flex Tables box click on 
the Hydraulic Analysist ab. Tables are characterized into Hydraulic Model — Shared 
— Predefined.   

Drainage and Utilities has ‘predefined tables’ set-up that can be edited as 
needed.  Expand the Tables – Hydraulic Model folder, here CTDOT Flex Tables are available 
for use and are formatted to show all information and data required. Should you have to 
edit to reflect information/data needed for the drainage computations, they still can be 
edited as needed specific to the project. Copy the flex table and rename project specific. 

 

Figure 71 Flex Tables 

CTDOT Gutter Flow Analysis, CTDOT Gutter Flow Analysis at Low Point and CTDOT Strom 
Drain Computation Sheet follows the computation sheets of the CTDOT Drainage Manual 
Chapter 11. 
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Figure 72 Flex Tables 

Double-Click on a flex table to open it. Each table has various tools such as: export, copy, 
paste, edit, zoom to, report, options and select in drawing. 
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Figure 73 Flex Tables Tools 

Export to File… — creates a text or csv file to work within Excel or shape file if needed. 

Edit… — allows columns to be added or removed from the flex table. Example: scroll in 
the Available Columns to X, click on Add. Now X is added to the Selected Columns side and 
click OK. X column is added to the catch basin flex table. 

Zoom To… — highlight a row and click on Zoom To, the active view will zoom in to the 
item/row selected and is highlighted. 

Report… — creates a report that can be printed. Paper size and page set-up can be edited 
in the report page. 

Options... — gives the ability to create selection sets.  

Create Selection Set — can be used to filter various items. As example to split up the 
drainage data into left and right side of the roadway.  

• Within the catch basin flex table select the catch basins for the left side of the 
roadway (highlight all left CBs using the CTRL key). 

• Click on the down arrow next to Options and select Create Selection Set…, type in 
selection set name: RteABC-LT. Click OK. 

• Repeat these steps for the catch basins on the right side of the roadway. 

• Click on the Utilities View tab and click on Selections Sets, click on Hydraulic 
Analysis tab. Here all Selection Sets for the project are stored. 
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Figure 74 Flex Tables 
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3.3.3 Profile for Drainage 

3.3.3.1 Single Pipe Profile 
You can view the profile of any single pipe between two drainage structures by right-
clicking on the pipe and hovering over for the pop-up menu to come up 
and picking the Open Profile Model bottom, it will ask to Select or Open View to place the 
Profile of the pipe. 

 

Figure 75 Single Pipe Profile 
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3.3.3.2 Profile Runs 
Profile Runs show hydraulic information such as Hydraulic Grade Line (HGL) and/or Energy 
Grade Line (EGL), show the depth of cover, and show whether slopes of conduits are in the 
same direction and magnitude as the road design. 

 
Figure 76 Profile Runs Tools 

Hydraulic Run From Node: will create one profile run from a selected node to the outfall, or 
between two selected nodes. 

 
Figure 77 Hydraulic Run From Node 

Hydraulic Run To Outfall: will create a profile run for every path, from farthest upstream 
node to the outfall. This tool will create profile runs for each run to the system outfall. When 
completed there will be 2 or more profile runs depending on the system. 

 
Figure 78 Hydraulic Run To Outfall 
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Utility Run From Links: will create a profile run from selected links, for any type of utility 
(storm, communication, sanitary, electric, water). The links must be consecutive without 
gaps between them. 

  
Figure 79 Utility Run From Links 

Project Run: This will project a previously created profile run onto a linear element such as a 
centerline or another profile run. Great tool to show the drainage structures and pipes on 
the road's centerline profile (vertical alignment). 

 
Figure 80 Project Run 
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In the Explorer, expand Profile Runs (click on down arrow); the newly created profile runs 
are now available to view. Right-click on the run to see all available options to view/edit 
the profile data. 

 
Figure 81 Profile Runs 

Open Profile Model – right-click on a Profile Run, select Open Profile Model – click in the 
view window to place the profile run. 

 

Figure 82 Profile Model 

Open Analysis Profile - right-click on Profile Run, select Open Analysis Profile - a window 
opens with the analysis profile. This can be modified to include Hydraulic Grade Line (HGL), 
Energy Grade Line (EGL), labels and table annotation and legend. The file can be exported 
to a drawing or can be printed.  
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Figure 83 Analysis Profile 

Saved as a pdf-file 

 

Figure 84 Saved as a pdf-file 
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Open Engineering Profile – right-click on Profile Run, select Open Engineering Profile - a 
window opens with the engineering profile. This can be modified to include inverts, slopes, 
types, length and more. The file can be exported to a drawing or can be printed and 
exported to a document. 

 

Figure 85 Engineering Profile 

Saved as a pdf-file 

 

Figure 86 Saved as a pdf-file 
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